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1. GENERAL CHARACTERISTICS OF THE MAXI BOX SOFTWARE

With the aid of the Maxi Box module and Maxi Key, the Maxi Box software controls the information
of transactions and events executed with the ZIP, ZIP LOADER, ZIP LOADER PLUS', CATERPAY
and CATERLINK payment systems?.

In particular, the Maxi Box Software is able to:
o Display data of single transactions or events.

e Calculate the total credit in the keys/cards in a given location, identified by customer code,
in a precise moment in time.

e Highlight errors occurred in the payment system.

e Carry out searches and printouts based on the following criteria: customer code, machine
code, key number, interval of key numbers, interval of time, user group, type of system,
type of event.

The Maxi Box Software has been tested with the following software versions: Windows XP,
Windows 2000, Windows 98 SE.

fl ATTENTION

1) The Maxi Box module can record all transactions when the peripherals (coin mech,
validator and note loader) are working properly. The module cannot record malfunctions
that are due to a signal failure from a peripheral (for instance, the note loader which, when
a banknote is inserted, fails to send the signal to the ZIP payment system).

2) When peripherals are used (coin mech, coin validator, note loader) controlled directly by
the machine (MDB, BDV Slave, Executive Slave), cash sales and any change given are not
recorded by Maxi Box.

3) When an Executive coin mech is used with ZIP programmed in the “CHANGEGIVER”
mode, the cash sale is recorded but the final credit shown by the Maxi Box Software may
not be correct because is not known if change (final credit) is given or not by the coin
mech.

4) When D.A. performs a test sale (Event 15) it is recorded as another transaction after
Event 15.

The above has nothing to do with calculating the credit stored in the keys.

1.1. KEY HARDWARE

The Maxi Box Software has a “Key Hardware” that has to be plugged into the connector for the
PC printer and left plugged in all the time the programme is being used. If the “Key Hardware” is
not plugged in, the programme will not work and a window appears on the PC screen showing
the following figure.

' The ZIP Loader Plus does not need the Maxi Box module because this function is performed by the
optional 512K RAM.
*The systems have to be updated to the firmware version given at the end of the manual.
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Maxi Box Software E
@ Hardware Key !

oK

2. MAXI BOX SOFTWARE MENUS

The Maxi Box Software consists of the following menus:

21. FILE MENU

With the file menu you can save and read the data from the hard disk previously acquired by the
Maxi Key as well as configure the software of the serial port, language, password and user data.

The options in this menu are:
¢ New Database: it lets you generate a new database for storing data sent from the Maxi

Key. This option is accessible also via the tool bar by pressing the key E
¢ Open Database: it lets you open a database saved previously. This option is accessible
also by pressing the key E

e Save Database: it lets you save the currently used database with another name. This

option is accessible also by pressing the key E
e Settings: it lets you open the menu for configuring the Maxi Box software. This option is
accessible also by pressing the key |E} .
e Esc: to exit the programme.

i)

—— All the PC programmes working with the serial port must be closed before starting the
Maxi Box software (the KeyCard programme must also be closed if it's active).

2.2. ACTIONS MENU

In this menu you find the options for working with Maxi Key. The options in this menu are:
¢ Read Maxi Key: this is used to acquire data from Maxi Key. This option is accessible also

via the tool bar by pressing the key g
¢ Reset Maxi Key: this is used to cancel data from Maxi Key. This option is accessible also

by pressing the key pa! |

2.3. DATA MENU

The options for working with the data collected by Maxi Key are in this menu, and are:
e Customers: with this option you gain access to the Customers table. This option is
accessible also via the tool bar by pressing the & | key.

e Search Function: with this option you gain access to the events search setting window
based on several criteria. This option is accessible also via the tool bar by pressing the

Q key.
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o Data Analysis: with this option you gain access to the window for calculating total credit
in the keys/cards by customer code. This option is accessible also via the tool bar by

ull

pressing the == key.

2.4. INFORMATION MENU

The Information menu contains information about the software version.

About X

B Maxi Box Software

“ersian 0.3.08TE
Developped by ADE s.rl

Weh Site: hittp: ade.it
E-mail: infof@ade. it

3. MAXI BOX SOFTWARE SETTING

Select the “File> Settings” menu (or press key F5). It will be possible to select the programme
language, the serial port to which the PC interface is connected, the password to enable access to
the programme and the data relative to the name and address of the company using the Maxi Box
Software. Once the settings are completed, press “OK” to store them.

i, Settings [Z| |E| E]

Language

" Italiano " Deutsch Campaty
f* Englizh LE. ™ Francaize % Pazsword
" Englizh LS

Fart

e COM 1 (™ COM &

 COM 2 ~ COME B o

~ COM 3 CCOMT X o
l"_" EI:IM 4 l:,—\_ EI:IM E (LTI U T II L IR LLIT TLI T I I T
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3.1. COMPANY MENU

With the Maxi Box Software you can set the name and address of the company using the
Software. The name and address will be displayed on the search printout sheets.
To enter the company’s name and address enter the “Settings” menu and choose “Company”.

i, Company

Address
Wia Galvani B, 33083 Villotta Di Chions [FM]

' 0K X Cancel |

3.2. PASSWORD MENU

The Maxi Box Software lets you set a protection password against unauthorised access. To set the
password enter the “Settings” menu and click on Password.

i Password

Enter new pazzword ]l

Canfirm new password ]

" OK | x Cancel ‘

Tap in the password (maximum 30 characters), confirm it and then press “OK”.

Confirm that the password has been entered by pressing “OK” in the settings window.

Each time the programme is started the window shown below appears, asking you to tap in the
password.

i MAXI BOX: Password

Enter password “

You can change the password any time by tapping in the current one and then entering and
confirming the new one.
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i Password

MM

FPaszwaord

HEEHEHER

Enter new pagzword

FESEEEHTY

Canfirm new passward

J OE. x Cancel |

If, once you've used the programme with the password, you decide to remove it, enter
Settings/Password, tap in the current password and confirm with “OK” leaving the “Enter new
password” field empty and “Confirm new Password”.

4. EVENTS COLLECTED BY THE MAXI BOX MODULE

Maxi Box is an optional module that can be interfaced with the ZIP and ZIP Loader® payment
system and can keep a track of all transactions (sales, revaluations, bonuses and so on). It can
store up to 4,000 transactions.

The way the system acts when this number is reached depends on how the “MAXI BOX:
OVERWRITING” parameter is programmed (ON/OFF).

If this parameter is programmed OFF, the payment system goes "out of order" when 4,000
transactions have been stored until the data are collected by the Maxi Key.

If this parameter is programmed ON the payment system continues recording transactions even
after 4,000 have been stored, overwriting them, starting from the very first (this means the last
4,000 transactions are always stored).

The events recorded by the payment system can be divided into the following categories:

e Revaluations

e Sales utilising credit (key)

e Sales without utilising credit (cash)

e Refunding bonuses and reward points
e Connecting with peripherals

e Other events

e Errors List

The table (see below) gives the types of event for each category that are recorded by the Maxi Box
module.

There are specific data for each type of event (see the columned data in the table below) that can
be or not be provided by the Maxi Box Software and other, common data that are always provided.
The data common to all events and which are always provided by the Maxi Box Software are:

e User Group: the group to which the key belongs is given or the department code if the UGs
are not used.
e Date, time: this is the date and time of the event.

® The Maxi Box function is performed by the optional 512K RAM in the ZIP Loader Plus and Caterpay.
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e Customer code, Machine Code, Reader Code: these are the programmed codes in the
payment system where the data are collected.
e Error code: if there are no errors “0” is indicated. If there is an error its code is given.

Event type and specific data:

Key Price | Quantity® | Starting | Final Value
Event type Number Line Credit Credit
Revaluation
Revaluations Coins YES - - YES YES YES
Revaluations Notes YES - - YES YES YES
Revaluations Coins & Notes YES - - YES YES YES
Revaluations Charge Key YES - - YES YES YES
Revaluations Programmer YES - - YES YES YES
Payroll Deduction YES - - YES YES YES
Revaluation using Credit on YES - - YES YES YES
Machine
Revaluation Bonus 1 as Credit YES - - YES YES YES
Revaluation Reward as Credit YES - - YES YES YES
Sales utilising credit
Cash Sales - YES YES YES YES YES
Key Sale Disc. Lev. 0 YES YES YES YES YES YES
Key Sale Disc. Lev. 1 YES YES YES YES YES YES
Key Sale Disc. Lev. 2 YES YES YES YES YES YES
Key Sale Disc. Lev. 3 YES YES YES YES YES YES
Sale Discount Band 1 (happy YES YES YES YES YES YES
hours)
Sale Discount Band 2 (happy YES YES YES YES YES YES
hours)
Sale Discount Band 3 (happy YES YES YES YES YES YES
hours)
Promotion YES YES YES YES YES YES
Cash Sale with Change ) YES YES YES RCredlt YES
efund
Sales without utilising credit
Free Sale Key YES YES YES - - YES
. YES YES YES number | number | number
Sale with Bonus 1
bonus bonus bonus
. YES YES YES number umber number
Sale with Bonus 2
bonus bonus bonus
Reward YES YES YES - - -
Returning Bonuses and
Reward points
Bonus Refund YES - - YES YES YES
Reward Refund YES - - YES YES YES
Connections with peripherals - -
Programmer - - - - - -
Databox (or Maxi Key - - - - - -
connected on DB9)

¢ Quantity: it is always 1 on ZIP, it can be greater than 1 on ZLP or ZIP Caterpay/Caterlink
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Maxi Key for Setup - -

Maxi Key for Maxi Box - - - - - -

Maxi Key for data collection - - - - - -

Handheld Psion or others - -

EVA-dts Terminal - - - - - _

Data Key

Setup Key

Black List Key - - - - - -

Other events

Change

- YES - - - YES

Overpay

- YES - - - YES

Errors list : see next chapter

4.1. ERRORS LIST

Maxi Box Software records “error” events.
Transactions containing these errors are displayed in red on the PC screen. By positioning the
mouse cursor on the error code and clicking twice the window shown in the following figure opens
giving a complete description of the event.

E9: Error during the key writing process

This event may occur when a key is removed during the writing process (red LED on).
= This event may alter the credit stored in the key (see event E1),

Below is a complete list of the events and their description provided by the Maxi Box Software.

ERROR
CODE

ERRORS LIST

E1:

Credit altered

The event may be caused by an error in the reading process: remove the key and
re-insert in the ZIP reader.

If the error persists (very seldom) this is due to a previous incorrect writing of the
key: the key could have been removed during the writing process.

The credit stored in the key is lost and the key can be recovered using the PC
interface.

E2:

Wrong key codes

The codes programmed in the key (Operator, Customer and Department code) do
not match the ones programmed in the ZIP system.

E6:

Wrong function code

The key function code (Sale, Free Sale, Programming) has been altered because
the key was removed during the formatting process. To recover the key use the Pc
Interface.
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E7: Credit exceeding limit
The credit stored in the key is higher than the max usable credit programmed in the
ZIP system (Other parameters/Maximum Credit).
ES8: Product not delivered
The vend price of the product not delivered will be re-added into the key when:
- VM provides ZIP system the information of "product not delivered" (not all VM do
S0);
- The parameter "Failed Sale Refund" is set to ON in the Zip system.
E9: Error during the key writing process
This event may occur when a key is removed during the writing process (red LED
on). This event may alter the credit stored in the key (see event E1).
E10: Error during data retrieval process
This event may occur when:
- 2 minutes do not elapse between two consecutives audits in the same ZIP
system;
- the connector of Data Box or Maxi Key is not properly inserted.
E11: Failed Revaluations using Charge Key
Product not delivered and vend price decremented from the key or no
E12: reloading
This event may occur when a key is removed during the writing phase (red LED
on). It can happen that the vend price is decremented from the key but the product
is not delivered. It could also be that during a reload the credit is neither transferred
to the key nor remains in the machine.
E13: Key inserted in the Black List
E15 Zero price vend requested as a test by the VM
E17 Change not given
Change as a result of a sale is not given at all or only in part.
E18 Manual return of coins from a coin mech
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This happens when the manual vend buttons are pressed on the front panel of the
coin mech.

The following table shows the data (those in the column) the Maxi Box Software highlights for each
event (error).

Key Price | Quantity | Starting Final Value
CODE Number | Line Credit Credit
E1 YES - - - - -
E2 YES - - - - -
E6 YES - - - - -
E7 YES - - YES - -
E8 - - - - - -
E9 YES - - YES - -
E 10 - - - - - -
E 12 YES - - YES - -
E13 YES - - YES -
E 15 - - - - -
- - - Sum to Sum Sum
E 17 give not given
given
- - - In the In the Sum
tubes at tubes given
E18 the at the
beginning end

i)

~—= On ZIP Loader Plus, error 9 can involve the two transactions preceding the one where the
error is. In this case, the Maxi Box Software highlights all three transactions in red.

5. TRANSFER OF DATA FROM THE MAXI BOX MODULE TO MAXI KEY

Both the Maxi Box module and Maxi Key have to be set appropriately so the various events can
be recorded in the Maxi Box module and so they can then be acquired with the aid of Maxi Key.

5.1. PREPARING THE MAXI BOX MODULE

The Maxi Box module can be connected to the ZIP systems featuring RAM expansion and
with the software updated®.

RAM expansion is essential because it is necessary to have a clock. When a Maxi Box module is
connected to a ZIP without the RAM expansion the payment system deactivates the peripherals
(coin mech, validator and note loader): the LED flashes to signal the error condition and error
messages are displayed.

When a Maxi Box module is connected to the ZIP system, the Programmer deactivates key/card
formatting.

® See the section in this manual that gives the software versions that are compatible with the Maxi Box.
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5.2. PREPARING THE MAXI KEY

To acquire data from the Maxi Box module, the Maxi Key must be set correctly via the Maxi Key
Manager software, following these few steps:

1. Set the “Data Collection from Maxi Box” operating mode.
2. Set the Maxi Key operator code which must be the same as that set in the payment system.

3. Set the key’s date and time.

@ The Maxi Key will proceed with acquiring payment system data only if the operator code
set in the payment system coincides with the one set in the Maxi Key.

The Maxi Key must have MK1.2.7 firmware or higher. Check the firmware version with the Maxi
Key Manager sw (see the Maxi Key User Manual).

5.3. DATA COLLECTION FROM THE MAXI BOX MODULE

Data is collected by plugging the Maxi Key into the DB9 connector normally used to program the
system.

While data is being acquired, the Maxi Key utilises the LED to communicate progress while the
payment system utilises the LED and, if available, either the 5-digit display or the LCD.

Maxi Key can collect up to a maximum of 28,000 transactions.

Since each Maxi Box module can hold up to 4,000 transactions, Maxi Key can collect the 4,000
transactions for a maximum of 7 systems.

Different intermediate situations are possible (like, for instance, 1,000 transactions for 28
systems) but Maxi Key can collect data for a maximum of 60 different systems.

o The Maxi Key LED:
When the Maxi Key is plugged into the DB9 connector of the payment system, its LED
flashes green. Once all the data are collected its flashes red if collection was unsuccessful or
remains a steady red if it was successful.

e Payment system LED:
When the Maxi Key is plugged into the DB9 connector the reader LED stays green until
collection is finished. If collection finishes correctly the LED turns red and stays red until the
key is disconnected. If there is an error the reader LED flashes red and green.

e 5-digit display
When the Maxi Key is plugged into the DB9 connector the display shows the message “Att . “
which remains until collection is complete.
- If collection finishes correctly the message “Out” is shown on the display.
- If there is a communication error the message “Err-10” is shown on the display.

e LCD
When the Maxi Key is plugged into the DB9 connector the word “Maxibox” appears on the
first line of the LCD.
- If collection finishes correctly the date and time are shown again on the display.
- If there is a communication error the message “Event 10” is shown on the display.
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@ To group the transactions of a location it is necessary that keys/cards with just
one Customer Code are used in the same location.

6. TRANSFERRING DATA FROM THE MAXI KEY TO THE MAXI BOX SOFTWARE

An interface for PC is needed in order to transfer data from the Maxi Key to the Maxi Box Software.
When the Maxi Key is connected by means of the DB9 connector located on the front panel of the
PC interface, the message “MAXI KEY CONTAINING AUDITS” message appears on the Maxi Box
Software status bar (see figure below) if it contains data sent from the Maxi Boxes, or the message

“MAXI KEY EMPTY” if it contains no data.

i Maxi Box Software

e ons Data Info

®|%) (0o 03¢ 6| 4

mumher User Group Date Hour Customer Code  Machine Code Reader Code Ewvent Type Price Line DQuartity Starting Credt  Final Credit  Walue Enor Code

0 110 22112/2004  8E7.00 0 ZIP001 000000 Revaluation Coing 9.70 950 020 o
G004 110 22/112/2004  867.33 0 ZIPN01 000000 FRievaluation Coins £.35 715 020 1}
242/2004 85813 1} ZIPn01 000000 Data Collection Maxi Box 1}

22/12/2004 90516 0 ZIPO01 000000 Programmer 0

G004 110 2212/2004 90640 0 ZIP001 000000 Revaluation Notes 715 815 1.00 o
0 110 22112/2004  9.07.10 0 ZIP001 000000 Revaluation Notes 215 915 1.00 o
G004 110 22112/2004 90744 1} ZIPN01 000000 Fievaluation Coins 815 335 020 1}
5004 110 2212/2004 90753 0 ZIPn01 000000 Revaluation Coins 935 555 020 1}
22/12/2004  9.03.08 0 ZIP001 000000 Drata Collaction Mawi Box o

22112/2004  9.21.02 1} ZIP001 000000 Pragrammer o

22112/2004 92442 0 ZIP001 000000 Programmer o

22112/2004 92456 0 ZIPN01 000000 Programmer 1}

5005 110 2212/2004 92654 0 ZIPn01 000000 Revaluation Coins 2,00 3,00 1.00 [t}
5005 110 22/12/2004  9.27.32 0 ZIP001 000000 Revaluation Coing 300 320 020 o
2212/2004  9.28.14 0 ZIP001 000000 Pragrammer o

22112/2004  9.31.04 1} ZIP001 000000 Programmer o

G003 110 22A2/2004 93150 0 ZIPno1 000000 Fievaluation Coing 950 370 020 1}
5003 110 242/2004 9353 0 ZIPn01 000000 Rievaluation Coins 870 550 020 1}
5004 110 22M12/2004 93218 0 ZIP001 000000 Revaluation Coins 2,00 2.20 020 o
2212/2004  9.33.05 0 ZIP001 0oo0oo Pragrammer o

G004 110 22/112/2004 93414 0 ZIP001 000000 Fievaluation Coing 2,20 240 020 [t}
G005 110 2212/2004  935.03 1} ZIPN01 000000 Fievaluation Coing 320 420 1.00 1}
242/2004 93542 1} ZIPn01 000000 Programmer 1}

5005 110 22112/2004 93619 0 ZIP001 0ooo0oo Revaluation Coing 420 470 050 o
G004 110 22112/2004  9.37.04 0 ZIP001 000000 Revaluation Coing 2,40 280 040 o
22/12/2004  9.37.48 0 ZIP001 000000 Data Collection Maxi Box o

2242/2004 94222 1} ZIPn01 000000 Programmer 1}

2212/2004 94249 0 ZIPn01 000000 Programmer 1}

5005 110 22112/2004 94354 0 ZIP001 000000 Revaluation Motes 470 9,70 500 o
6005 110 2212/2004 9447 1} ZIP001 000000 Revaluation Coing 970 950 020 o
5004 110 22/12/2004 94445 0 ZIPD01 000000 Fievaluation Coing 2,80 300 0.20 o
22112/2004 94646 1} ZIPN01 000000 Programmer 1}

5004 110 2A2/2004  947.22 0 ZIPn01 000000 Revaluation Notes 3,00 8,00 5.00 [t}
5004 110 22/112/2004  9.47.43 1} ZIP001 000000 Revaluation Coing 8,00 8.20 020 o
B 1l 22/12/2004  9.47.47 0 ZIP001 000000 Revaluation Coing 820 240 020 o

MAXIKEY CONTAINING AUDITS

If the Maxi Key contains data, choose the “Read Maxi Key” option from the “Actions” menu or

select the i push button on the tool bar.

The Maxi Key reading operation is divided into the following two phases:
e Transfer of data from Maxi Key to the PC.

e Updating of the database in the PC.

During the first phase the number of acquisitions and transactions for each acquisition collected by
the Maxi Key (see figure below) are constantly updated on the status bar of the Maxi Box Software

main window.

During the second phase, the message “UPDATING DATABASE” (see figure below) appears on

the Maxi Box Software status bar.
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5005 110 22M2/2004 93619 il ZIPOmM 000000 Revaluation Coins
5004 110 22M2/2004  9.37.04 il ZIFOm 000000 Revaluation Coins
22M12/2004  9.37.48 0 ZIPOmM 0a0oaa [ata Collection Maxi Box
22M12/2004 94222 1] ZIPOM 000000 Prograrnrner
22112/2004 342,43 1] ZIFOM 000000 Programmer
5005 110 22M2/2004 94354 0 ZIPOm 000000 Revaluation Motes
5005 110 22M2/2004  9.4417 1] ZIFOmM 000000 Revaluation Coinz
5004 110 22M2/2004  9.44.46 il ZIPOM 000000 Revaluation Coinz
22112/2004  9.46.46 ] ZIPOM 000000 Prograrnrmer
a004 110 22M12/2004  9.47.22 1] ZIFOM 000000 Revaluation Notes
5004 110 2212/2004  9.47.43 il ZIPOm 0aooao Revaluation Coing
5004 22M2/2004  9.47.47 il ZIFOmM 000000 Revaluation Coinz

UPDATIMG DATABASE

Audit: 2 Transactions: 4

If the Maxi Key contains a lot of data, the Maxi Key reading operation could take several minutes.

7. DATABASE MANAGEMENT

When the Maxi Box Software is installed in the PC the database is empty. It is created and
automatically saved with the first reading of a Maxi Key. Subsequently, when the Maxi Box
Software is opened, the list of transactions in this database is displayed.

When there are other data transfers using the Maxi Key, the data relative to the transactions are
entered in the active database.

The user can save the active database, create a new one or open a database that is already in
the PC memory whenever he wants. These operations can be done with the following push
buttons:

E (Save Database), m (New Database) e E] (Open Database)

e Save Database: to save the active database with a name.

¢ New Database: to generate a new database for storing data coming from the Maxi Key .
Selecting this function the following message appears:

Attention !

L] E Current data will be lost. Do you want to save the data ?
L

Si Mo Annulla |

After you have given the file a name and confirmed it, the following appears:

Maxi Box Software [X]

Task performed carrecty
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If, instead, you decide not to make a backup copy (selecting “NO”) the message shown above
appears immediately followed by an empty page.

By plugging the Maxi Key in the data will be transferred to this new database.
e Open Database: to open a database saved previously.

Selecting this function the following window opens:

L] E Current data will be lost. Do you want to save the data ?
[ ]

Si | Mo Annulla

Selecting “YES” the procedure is exactly the same as the “New Database” function”.
Selecting “No” the following window opens:

Cercain:li.;j[lata _:_1 = & ¥ BB~
"; prova211204.dbk
"==:) prova 2.dbk
Documenti prova 3.dbk
recenti
F"[:
Desltop

Documenti
Risorse del
computer

<

Risorse direte  Nome file: I| _:_J Apri

Tipo file: ]database backup format _:J Arinulla

Now, selecting the name of the Database you want to see, the window shown below opens and,
following confirmation, the data will be displayed.

15/25



SOFTWARE MAXI BOX: OWNER’S MANUAL

Maxi Box Software [X|

Task performed correctly

...........................

...........................

i)

~— |t is only possible to carry out searches and calculate the credit remaining in keys/cards
by Customer code on one database at a time.

It is not possible to combine data relative to two separate databases in a single database.

8. CUSTOMERS TABLE

The data managed by the Maxi Box Software come from different locations. We recommend
identifying the locations by means of a Customer code. With the Maxi Box Software you can

display all the Customer codes by means of the “Data->Customers” menu or by selecting the & |
push button on the tool bar.

The Customers table is displayed after this command has been given which comprises the
following three fields:

e Customer code

e Name
e Address
ome - BIX
i 4 = + - o
Custarner Codel MHame Address | i
N i] ABC Spa Via Galvani B, 33089 Villata Di Chions [PH)
12 Blue Buyte Via Kennedy 45, Mestre [WE] Italy
m Universita di Udine Via Mantegna 8, Udine [taly

The Customers table is automatically updated with any new Customer codes each time the Maxi
Key is read.

It is the Operator’s job to give the name and address to each Customer code. As a matter of
fact by clicking twice on the line giving the Customer code it is possible to access the window that
lets you enter the name and address.
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) | B 1 e I

Customer Codel Sddress |
i] ABC Spa ions [PM)

12 Blue Byte

110 l—
Customer Code B

Mame I

p=l |

Address ||

« 0K | X Cancel J

The Customers name and address fields that are already listed in the table can be modified at
any time by clicking on the “*” key on the Customers bar.

It is also possible to add a new client manually by clicking on the “+” key of the Customers bar.

@ It is not possible to delete a Customer code from the Customers table as you
would no longer be able to find the data relative to transactions already in the database.

9. SEARCHES

With the Maxi Box Software you can search the data in the active database.
Parameters to help you search can be taken from a configuration window, recallable from the

“Data->Search Function” menu, or selectable by pressing the [ﬂ button.

The parameters that can be utilised to carry out searches are:
e Customer code
e Machine Code
e Key Number
e Date
e Time
e User Group
e System type
e Eventtype
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i Search Function

Search Parameters
Customer Code / Machine Code- Key Mumber
[ Select {+ Mo Constraints
&k Q 04BC Spa © Single 0000
Q 12 Blue Byte B
+ @ 110Universta diUdine :
™ Single | :
" Date from 124 J (0F
Hour
I~ Hour 16 21 — 1631 -—
Uszer Group
(* Mo Constraints
" Single ]
" Usger Group
Frint Machine tupe-
& Full List [ Select zIP |
" Tranzaction per machine
Event Tupe
¢ Transaction per key [ Select ]Hevaluation Caing j
W OK x Cancel ‘

Search results can be displayed in three different ways, selecting them from the configuration
window:

o Fulllist
e Transactions in machine order
e Transactions in key order

@ Suggestions:

1. Identify each location with a different Customer code and identify each system with a
different Machine Code.

In actual fact, when the search window opens the Maxi Box Software executes a search in all
the data it has in its database, extracting the Customers Codes and Machine Codes in the
files and putting them in a tree display.

With this type of display you have rapid and immediate access to your portfolio of
Customers/Machines.

To activate this display you have to tick the "Customer code / Machine Code” field.
By clicking on the Customer code you can access all the machines belonging to that particular
Customer code, as shown in the following figure.
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Search Parameters:
Customer Code / Machine Code K.y Humber
[ Select t« Mo Constraints
4| Q ﬁ " Single
S 12 Blue " from
—| (&) 110 Universta diUdns el :
t« Mo Constraints
z P ZIFD03 ™ Single f200E
ZLPOD3 Vet 2005 = 2701 .
Hour
[~ Hour i —— f ——
Uzer Group
t* Mo Constraints
™ Single
" User Group
Frirt tachine type
& Ful List [~ Select jzip e
(™ Transaction per machine
Event Type
(" Tranzaction per key I~ Select |F|eva|uatian Caing j
" OF X Cancel |
Each machine has its own id code as well as an icon that indicates whether it is a Zip( ), ZIP

2 :
Loader( ), ZIP Loader Plus (), Caterpay (') or Caterlink ( ﬁ ) payment system.

2. How to see all the transactions by Customer code and for a certain type of System (i.e.

all the transactions of the ZIP Loaders for a specific Customer code).

Select a Customer code (the Customer code turns blue) and select “Machine Type > ZIP
Loader”. Once you have selected the type of system the Customer code turns grey.
Selecting “OK” it is possible to see all the transaction for that “Machine Type” belonging to that

specific Customer code.

Only one Customer code can be selected at a time.
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i Search Function
Search Parameters

Customer Code / Machine Code- Key Mumber
[ Select {+ Mo Constraints
- Q 0 ABC Spa ™ Single I 0000
S 12 Blue Byte {" fom I— T ’—
x| @ ‘m:l Universi d I_I-:Iir'nse’ e _
: (* Mo Constraints
S R R e
™ Single 120172005 =
" Date from 12400 4 200F E J 20 A200F
Hour
I Hour i 16 21 —_ Ty 1631 -—
Uszer Group
(* Mo Constraints
" Single I
" Usger Group i Tt
Frint Machine tupe-

t+ Full List i~ S@P Loader )

" Tranzaction per machine

Event Tupe

(" Tranzaction per key I~ Select ]Hevaluation Coing j

v‘ Ok x Cancel ‘

3. Searches on specific Machine Codes.
Select the Machine Code from the tree menu and start the search. When a Machine Code is
selected from the tree menu the “Machine Type” is disabled automatically.
Only one Machine Code can be selected at a time.

9.1. PRINTOUTS

Once the search parameters have been defined and the display method chosen, by clicking on

Once the print preview has been disEIai/ed, by clicking on = you can choose the printer and

then print the search by clicking on
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Printed:

V4|

12/01/2005 8.54 59

ADE Srl

Via Galvani 6, 33089 Villotta Di Chions (PN}

Full List

Customer Code - Mo Constraints Hour : Mo Constraints
Machine Code : Mo Constraints User Group : Mo Constraints
Key Mumber - All Machine type Mo Constraints
Period : Mo Constraints Event Type : All

Customer Hey LG Dizte Time  Machine Ewvent Type Qi SmrCr Final Cr Value Error
110 05/02/2000 15.10.11 ZIP0O3 Data Collection Maxi Box 0
110 05/02/2000 15.23.24 ZIPO03 Programmer 0
110 08/12/2004 16.32.38 ZLP003 Data Collection Maxi Box 0
110 133 30 09122004 16.36.35 ZLPOO3 Key Sale 1 16,60 14 20 2,40 0
110 133 30 091122004 15.36.35 ZLPO03 Sale with Bonus 2 1 1 0 1 0
110 133 30 0912/2004 16.35.35 ZLPOO3 Key Sale 1 1420 11,70 250 0
110 133 30 09122004 16.36.35 ZLPOO3 Reward 1 0
110 5002 11 08MZ/2004 16.37.36 ZLPOD3 Key Reading 566,24 2
110 131 30 09M2/2004 168.38.04 ZLPOO3 Key Sale 1 17,60 16,20 1,40 0
110 131 30 091202004 16.38.04 ZLPOO3 Key Sale i 1820 13,30 280 0
110 131 30 09122004 16.38.04 ZLPOO3 Reward 1 0
110 131 30 091202004 16.32.04 ZLPOO3 Reward 1 0
110 131 30 09M2/2004 18.38.04 ZLPO03 Key Sale 1 13,30 12,30 1,00 0
110 131 30 0%12/2004 1638 04 ZLPO03 Reward 1 0
110 131 30 01202004 16.38.04 ZLPOO3 Key Sale 1 1230 11,30 1,00 0
110 130 30 09122004 16.38.51 ZLPO03 Key Sale 1 15,80 14 40 1,40 0
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9.1.2. TRANSACTIONS IN MACHINE ORDER

ADE Sri

|
E Ii Via Galvani 6, 33089 Villotta Di Chions (PM)

Printed:

12/01/2005 8.56.26 Transactions per machine

Customer Code : Mo Constraints Hour : Mo Constraints
Machine Code : Mo Constraints User Group : Mo Constraints
Key Mumber : All Machine type : Mo Constraints
Period - Mo Constraints Event Type - All

CUSTOMER 00000 ABC Spa

Via Galvani 6, 33089 Villota Di Chions {(PN]

Machine ZIP0H

Key Number U.G. Dize Time Start Cr. Final Cr. Value
191272004
1911272004
181272004
191212004 11.52.22 Data Collection
1901272004 11.54.00 Programmer

181272004
1891272004
181272004
1911272004
21122004
21122004
2122004
2122004

Event Type Q.iy
11.45.47 Data Collection Maxi Box
11.50.35 Programmer

11.50.54 Programmer

11.54.08 Programmer

11.56.57 Programmer

11.58.56 Rewvaluation with credit on machine 535 10,20 0,35
12.00.51 Revaluation with credit on machine 6,30 7,30 1,00
13.56.30 Programmer

14.16.18 Programmer

14.31.48 Programmer

14.32.57 Data Collection Maxi Box

3

2122004
21122004

14.33.27
14.33.56

Programmer

Data Cellection M axi Box
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9.1.3. TRANSACTIONS IN KEY ORDER

EPrinted:
12/01/2004

Z|P

ADE Srl

Via Galvani 6, 33089 Villotta Di Chions (PM)

8.58.43 Transactions per key

Customer Code
Machine Code :
Key Mumber -
Period :

: Mo Constraints
Mo Constraints
All
Mo Constraints

Hour : Mo Constraints
User Group : Mo Constraints
Machine type - Mo Constraints
Event Type : All

CUSTOMER 00000 ABC 3pa

Key Number
na Dare

1812200
18M2200
19127200
19127200
19127200
18127200
18M2r200
212200
212200
21127200
21127200
212200
2112200
HNZE00
2MM2rzon
211127200
22200
212200
212200

Via Galvani 6, 33089 Villota Di Chions (PH]

Time Mzehine Ewvent Type

11 45 47 ZIpooq  Data Collection Maxi Box
11.50.36 ZIPoo1  Programmer

11.50.54 ZIPoOo1  Programmer

11,5222 ZIPoni1  Data Colliection

11.54.00 ZIpoo1  Programmer

11.54.08 ZIPoo1  Programmer

11.56.57 ZIpooq1  Programmer

13.56.30 ZIPOO1  Programmer

14.16.16 ZIPOO1  Programmer

14.31.46 ZIPOO1  Programmer

14.32.57 ZIropq  Data Collection Maxi Box
14.33.27 ZIPo01  Programmer

14.33.56 ZIPonq  Data Collection Maxi Box
14.34.05 ZFipooq  Data Collection Maxi Box
14.34.15 ZIPoo1  Programmer

14.35.02 ZIPonq  Data Collection Maxi Box
143515 FIrooq  Data Collection W axi Box
14.35.21 ZIPoo1  Programmer

14,35 49 ZIPooq  Data Collection Maxi Box

Oy Smxlr Final Cr. Value
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10. CALCULATING THE CREDIT IN THE KEYS/CARDS DIVIDED BY CUSTOMER
CODE

The Maxi Box Software lets you calculate in a precise instant (date and time) the total credit in
the keys/cards by Customer code.
1]

When you select the “Data->Data Analysis” menu or by selecting the == button on the tool bar,
the following dialogue window opens in which you can enter the precise instant of the search

(date and time).

. Credit stored in the Keys up to...

Date Tirne
[[E/01/20058 | | 859.29 =
o 0K x Cancel |
-

By pressing OK the window shown below opens which indicates the total amount of credit in the
keys/cards for each Client in the active database.

The value of the credit is calculated according to the date and time parameters chosen previously
(i.e.: date 10/12/04, time 14.52).

numbered individually in each location (identified by a Customer code).

AD‘ In order for this function to generate correct values the keys/cards must be

] ADE Sri

E IE Via Galvani 8, 33089 Villotta Di Chions (PN)
Printed:

12/01/2005 Credit stored in the Keys up to 12/01/2005

Customer Name Address Value
0 ABC Spa Via Galvani 6, 33089 Vilota Di Chions (PN) 92,90
12 Blue Byte Via Kennedy 45, Mestre (VB ttaly 0,00
110 Universita di Udine Via Mantegna 8, Udine ltaly 1146,60
Credit stored in the Keys 1239.50
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11. PAYMENT SYSTEM VERSIONS COMPATIBLE WITH THE MAXI BOX

Conpas Zip Zip Zip Zip Zip Zip
Negative Loader Loader Caterpay | Caterlink
Credit Plus
Maxi Not Z 247 Z 547 or ZC 220 or | ATD1 3.0.5 Not Not
Box available | or later later later or later available available

Module
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